Installing Eclipse (C++/Java)

Installing Eclipse (C++/]Java)

The current suite of text-based languages, Java and C++, utilize the current version of Eclipse
as a development environment. The FRC specific tools for the chosen language are installed as
Eclipse plugins. You can install both the Java and C++ development tools into the same
installation of Eclipse to allow programs to be written with either language using a common
set of tools and user interface.

The Eclipse plugins have been tested with Eclipse Luna, Eclipse Mars, Eclipse Neon, and Eclipse
Oxygen. Teams with existing installs from 2017 can update their installations to 2018 by
following the updating the plugins when prompted by opening Eclipse (if automatic update is
enabled) or following the Updating the plugins manually instructions below. C++ teams should
also install the new toolchains (Installing the C++ Toolchains).

CAN Talon SRX has been removed from WPILib. See this blog for more info and find the CTRE

Toolsuite installer here: http://www.ctr-electronics.com/control-system/
hro.html#product_tabs_technical_resources

Note: The C++ and Java tools and environment are available for Windows, Mac OSX and Linux,
though the Windows version is the one that has been the most heavily tested. You should be
able to use any of the three for your development platform, however you should keep in mind
that you will need a Windows computer to run the Driver Station software and roboRIO
Imaging tool.

@© Warning: Java 9 is not currently supported by the FRC tools. Java 9 introduces many
breaking changes, and is not provided for 32-bit systems which we need to support. Java 9
will not be supported for 2018.

Installing Eclipse (C++/Java) Last Updated: 12-14-2017 Page 1


http://www.firstinspires.org/robotics/frc/blog/2017-control-system-update
http://www.ctr-electronics.com/control-system/hro.html#product_tabs_technical_resources
http://www.ctr-electronics.com/control-system/hro.html#product_tabs_technical_resources

Installing Eclipse (C++/Java)

Getting Java

Java SE Development Kit 8u151

You must accept the Oracle Binary Code License Agreement for Java SE to download this

@ Accept License Agreement |

Product / File™d

Decline License Agreement
Download

Linux ARM 32 Hard Float ABI 77.9MB #|dk-8u151-linux-arm32-vfp-hflt.targz
Linux ARM 64 Hard Float ABI 7485 MB #jdk-Su151-linux-arm&4d-vfp-hflt.targz
Linux x86 168.95 MB #dk-8u151-linux-i386.rpm

Linux x86 18373MB  #jdk-Bu151-linux-i586 targz

Linux x64 166108 #idk-2u15]linupcxs m

Linux xG4 . .
mMacos x86/64 should match Eclipse version
Solaris SPARC 64-bit i e i M an v

Solaris SPARC G4-bit 9932 MB #|dk-8u151-solagl-sparcvd.targz

Solaris x64 140,65 MB  #jdk-Bu151-504fris-x64 tarZ

-

Windows x86 198.04 MB #dk-Bu151-windows-i586.exe

Windows x64 20595 MB  #jdk-Bu151-windows-x64 exe

To use Eclipse you must have a Java 8 DK installed on your system. You can get Java from the web

site: http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html.
Do not select Java 9!

Scroll down the page to "Java SE Development Kit". Accept the license agreement and download
the Java SDK for your platform. The version (either x86 or x64) should match the version of Eclipse
that you have installed or plan to install on your computer. This has been tested with Java SE
8u151 but will probably work with later versions as well.

Java 8 is installed on the RoboRIO and to take advantage of all the features it offers, it is suggested
that you use Java 8 on your development system. You may use an earlier version, however it
should be noted that the rioLog Eclipse plugin which is used to view console output requires Java
8, and other WPILib tools (dashboards, etc.) may as well.

Note: Java is required to be installed even if you are doing C++ development since Eclipse, the
development environment, is a Java program. Also, the Oracle web page might change over time,
so the images shown here might not exactly match what you see.
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Installing the C++ Toolchains (C++ teams only)

4 FRC Toolchain Setup ool

Please read the FRC Toolchain License
Agreement

GNU GENERAL PUBLIC
FIRST Rebolics Enm;.‘:f.-ﬂﬂﬂn LICEN SE

Yersion 3, 29 June 2007

Copyright @ 2007 Free Software
Foundation, Inc. <http://fsf.org/ >

Fvervone is permitted to copy and
distribute verbatim copies of thiz license

docurment, but changing it iz not allowed. -

[¥]1 accept the terms in the License Agreement

Back [ Install ] [ Cancel

If you have toolchains installed from a prior season, you should uninstall them using Add/
Remove and install the new toolchains

Download the appropriate C++ Toolchains installer for your platform from http://first.wpi.edu/FRC/
roborio/toolchains/

Windows: Double click on the downloaded file to launch it. If you receive a Security Warning, click
Run. Check the box to accept the License Agreement, then click Install. When the install completes,
click Finish.

Mac OSX: Double-click on the downloaded file in Finder to unzip it. In Finder, right-click on the "FRC
ARM Toolchain.pgk" file, then press the option key on your keyboard, and click "Open". Follow the
steps to install the package.
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Linux: See the instructions in the text file on the toolchains page.
@) The Windows toolchains will always install to the root of the system drive.
Getting Eclipse

= eclipse -

L : ™ Q7
Are you rea dy forjava CE Become a Friend of Eclipse

Eclipse Luna includes official support for Java 8 in the Java development tools, Plug-in
Dew yment Tools, Object Teams, Eclipse Con 1 <, M 'n integration,
yd, Web Tools Platform, and Memory Ana

# Projects
. BCH} Barcelona JUG GBearcelons
M

Installing Eclipse (C++/Java) Last Updated: 12-14-2017 Page 4



Installing Eclipse (C++/Java)

Download Eclipse

Windows

I:u;.".']; 166 ME 918,911 DOWRNLOADS

e

The essential tools for any Java developer, including a Java IDE, a Git client,
XML Editor, Mylyn, Maven integration and WindowBuilder...

32/64 should match Java version

i~
e' - 176 ME 377,192 DOWNLOADS

An IDE for CfC++ developers with Mylyn integration.

You can get eclipse from the web site: https://www.eclipse.org/downloads/eclipse-packages/

Select the version of eclipse that matches your desired programming language (there are
instructions below for adding C++ to Java or Java to C++). You should choose the version of eclipse
that matches your operating system and version of Java from above.

At the time of this writing the current version is Oxygen (4.7) and that is what we've been using for
development of the tools. On the next screen choose a download site and start the download.
Choose a location such as the downloads folder for the zip file.

Note: on 64 bit Linux systems it might be necessary to install 32 bit version of libc. For example, on
Ubuntu Linux, the command would be:

sudo apt-get install 1libc6-i1386

This is necessary to run the gcc binaries as part of the plugins since they are compiled for 32 bit
linux.

¢ Eclipse also provides .exe installers now. Other than changing the next few instructions,
these should work fine as well.
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Unpack the eclipse folder and move it to Program Files

”.

uuv‘ 4 » brad » Downloads »

__v- | +4 | | Search Downloads

& Downloads
@ Dropbox (Mac) £
(& iCloud (Mac)
@ Photo Stream (M

CE
=) Recent Places

i
. Libraries

FEI Documents

Open

Cpen in new window

| Extract All...

Show in Finder

Open with

Share with

Organize - = Open - Share with - Burn Mew folder 4= -
i Favorites Mame Date modified Type Size
B Desktop | 1 eclipse;ron-kenler-SR1 -win3? 1017/20134:29 PM  Compressed (zipp... 143,586 KB|

Extract the contents of the zip file by right-clicking on the .zip file in a windows explorer window
and selecting "Extract All..." and taking the default for the location to extract it.
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Move the extracted eclipse folder to Program Files

. ¢ brad ¢ Downloads » eclipse-cpp-kepler-SR1-wind2 »

€10N

-J' Music = Mamie Date modified Type
= Pictures
B videos

1017/2013 4:37T PM File folder

(B Computes
&, Lecal Disk (C)

. Program Files

. ‘Windows
@ OVD Drive (D:) P2
e b Bk WD

Move the extracted folder to Program Files or some other convenient location from which to easily
run it. Within the eclipse folder you'll see the file "eclipse.exe". You can right-click on "eclipse.exe"
and select "Pin to start menu" to make it easier to run eclipse without having to find the
installation location.
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Starting Eclipse for the first time

'3 Workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

] Uz this as the default and do not ask again

Start Eclipse (it will be on your start menu if you chose to pin it from the previous step.) The first
time Eclipse starts it will ask you for the location of your workspace. A workspace is the location on
disk where projects and files are stored by default. You can have more than one workspace, but
it's suggested to take the default location until you have more experience with Eclipse.
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Adding C++ to Java Eclipse

pr— [
type filter text Java "~ Ty
» (General N
If C++ is missing, thendo | -
o C/Ces the next step, otherwise  Jge Bxplorer
hangslog skip the next step -
= Help 1
» Install/Update
- | Java

» Library Hower
= Mylyn
» Remote Systems
= Run/Debug
» Specfile Editor
= Team
Terminal
= Tracing

@

When cpening a Type Hierarchy

(") Open a new Type Hierarchy Perspective
i@ Show the Type Hierarchy View in the current perspective

Refactoring Java code

[] Save all modified resources automatically prior to refacte

1 | m | 3

Lok ]

Cancel ]

To program C++ with the Java version of Eclipse, you will to have the C++ Development Tools (CDT)
installed. To determine if they're already installed, select Window, then Preferences from the menu
bar. Then look for C/C++ on the left side of the Preferences window. If it is missing then you must

install it. The installation procedure is in the next step.
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Install Eclipse C++ Development Tools

= Install ] |
Available Software
Check the items that you wish to install. _‘:)i
Work with: l Mean - B - Add...

tupe filter text

4 [H 000 Programming Languages
e ATRETS eI S n ot
o

[ 4 C/C++ Berkeley UPC (Unified Parallel C) Teolchain Suppert

e OG-+ Ca aoh alizatio

[] 4# C/C++ Docker Container Launch Support
[ 4 C/C++ IBM XLC Compiler Support

[ Select All ] [ Deselect All 1 itern selected

Details

Show cnly the latest versions of available software

Group items by category

[] Show only software applicable to target environment

Contact all update sites during install to find required software

Eclipse C/C++ development toels, Binary runtime and user documentation.

Find more software by working with the "Available Software Sites” preferences.

Version .

8.8.0.201509131935
8.8.0.201509131935
4.1.0.201509161915
8.8.0.201509131935
£.8.0.201509131935
8.8.0.201509131935
8.8.0.201509131935 Z

More...

Hide items that are already instzalled

What is already installed?

< Bach Next > Frsr

If C/C++ is missing from the preferences window (see previous step), then it must be installed

Noupwn =

Close the Preferences window if it's open.
Select Help, then Install New Software... from the menu bar.
Click the dropdown and select the "Neon" site as shown.
Scroll down to the Programming Languages section and click the arrow to expand.
Click the checkbox to choose Eclipse C++ Development Tools
Click Next.

Take the defaults for the other options and let Eclipse restart.

When these steps are finished, and Eclipse has restarted, C++ should be an available option on the
Preferences window, and all the C++ perspectives will be available.
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Adding Java to C++ Eclipse

Preferences Elmi
type filter text Java =l - -

> General N i
> Ant If Java is missing, thendo | 3
> G/ the next step, otherwise  |ge Bxplorer

Changelog skip the next step |
= Help 5

e v

ibrar Hoy When cpening a Type Hierarchy M

= Mylyn (7} Open a new Type Hierarchy Perspective

> Remote Systems i@ Show the Type Hierarchy View in the current perspective
= Run/Debug

» Specfile Editor

El

Team Refactoring Java code

Terminal [] Save all modified resources automatically prior to refacte

= Tracing 4| m | k

@ [ ok || cancel |

To program Java with the C++ version of Eclipse, you will need to have the Java Development Tools
(JDT) installed. To determine if they're already installed, select Window, then Preferences from the
menu bar. Then look for Java on the left side of the Preferences window. If it is missing then you
must install it. The installation procedure is in the next step. If you do have the Java development
tools installed (Java is shown), then skip the next step and continue configuring to Setting up the
JDK'in Eclipse.

Installing Eclipse (C++/Java) Last Updated: 12-14-2017 Page 11



Installing Eclipse (C++/Java)

Install Eclipse Java Development Tools

If Java is missing from the preferences window (see previous step), then it must be installed

Noupwn =

Available Software
-

Check the Aems that you wish ko install, o
CA
= N
e

Work withf] Necn - http://

type filter test

4 [ 07 Programming Languages
- d Parallel C) Toelchain Support 24.0.20140611175
° < 3.0.0.20140510040
N % 2402040611175
8402014061175
1002014061175
4020140611175
1102014061175 =
1.20201405271 22
4020140611175,
8402014061175
210200406101
210200406081
21.0.v20140606-1
5.0.0.20130606070
540.0.20130606070

.e & Dy Languages Toalkit - TCL Development Tooks 5.0.0.20130506070
Taals 50.0.20120806070
[F] 4+ Extipze Java Development Tooks ] 320.0.20040606-.

360.7I014050671

.
Select All Deselect Al 1 item selected

Details

[¥] Show only the kstest versions of availsble software ] Hide items that are already instaled
7] Group #=ms by cotegary Whatis clready installedl?
|| 2 Show anky safware appiicable to target environment

9] Contsct all updste sites during mnstsll to find reguired software

Close the Preferences window if it's open.
Select Help, then Install New Software... from the menu bar.
Click the dropdown and select the "Neon" site as shown.

Scroll down to the Programming Languages section and click the arrow to expand.

Choose Eclipse Java Development Tools

Click Next.

Take the defaults for the other options and let Eclipse restart.

When these steps are finished, and Eclipse has restarted, Java should be an available option on the

Preferences window, and all the Java perspectives will be available.
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Setting up the JDK in eclipse (Java teams only)

_pkﬁg
| | type fitter text Installed JREs = r w
A
a pf:i;al‘:e Add, remove or edet JRE definitions, By default, the checked IRE 12 added Lo the build path of newly crested lava -
uild Patl projects.
Code Style
Compiler Instalbed JREs:
Deb
p— hlarme Location Type Add_.
4 Installed JREs = ¥ Bijrel80 20.. CAProgram Files [x86))ladl\jdk1.8.0_20 Standard .. Edit..
e - r
Wnit . Duplicate.., |
Propertses Files Editor
: Rernowve
Library Hower -
Mylyn Search...
Bermints Tueteme .
m [
"" [ QK | Cancel |

—

. Select Windows from the menu bar, then Preferences.

2. Choose Java preferences in the list on the left of the Preferences window, then Installed JREs.

3. Besure that the installed JDK is selected as shown (make sure the "Location" field includes jdk 8
or 1.8, the name field may be the same in either location). This will enable eclipse to build Java
programs for the RoboRIO. Without this setting you will see error messages about the JRE path
not being set correctly.

If you have no entries, or your only entry does not say jdk in the Location, proceed with the next
step. Otherwise, skip the next step.
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Adding the JDK

& Preferences B %
© Add IR ==

ype iter ] . oo

. Genersl | | JRE Type [\ | Esuiapetn

I
Installed JRES G~
Add, 1 By defaul, the checked IREis added to the build path
of new

S Add JRE B %

JRE Definition 2\

mg —

> . Intemet Explorer
> 1L MiFoundation
4l Java
) jdd70.51
bin g
> i db
include
> jre
> ib

> U et
LSl SoftMadem

©) Foder:  KL7.0.51

Ci\Program Files (6)\}

Only if the JDK is not shown in the step above:

Click Add

Select Standard VM

Click Next

Click Directory and browse to the folder for the JDK (usually C:\Program Files\Java\* or
C:\Program Files (x86)\Java\*). The image shows jdk1.7.0_51, you will likely have a jdk1.8.*
version.

Click OK. Pick a name for the JRE such as JDKS.

Click Finish

7. Make sure the box for the newly added JDK entry is checked.

Eal

o wm
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Configuring eclipse

-
— Preferencez

ER=0

[
°'JE filter text

==a General
. Appearance
Compare/Patch
Content Types
> Editors

Keys

Perspectives
Search
> Security
> Startup and Shutdoy
Web Browser
> Workspace
. Ant N
o C/C++
Changeleg
> Help
> Install/Update
> Java
> Library Hover
> Mylyn
> Remote Systems
» Run/Debug
] m b

> Metwork Connectior

m

Workspace LT A

See 'Startup and Shutdown' for workspace startup and shutdown preferences.

Build automatically

[] Refresh using native hooks or polling

Refrech on access

_ Save automatically before build

[] Always close unrelated projects without prompt

Workspace save interval (in minutes): 5

Workspace name (shown in window title):

Open referenced projects when a project is cpened

) Always () Never @ Prompt
Text file encoding Mew text file line delimiter
@ Default (Cpl252) @) Default (Windows)

~) Other: | Cpl252 ~) Other | Windows

I Restore DefaultsJ I Apply

)

@_ ok || cancel |

There are a huge number of configuration options for eclipse to set up the environment for your
preferences. One suggested setting to note is: "Save automatically before build." This setting will
cause all of your workspace changes to be saved when you build the project. If you don't set this,

remember to save changes before building, otherwise the rebuilt program won't reflect your

newest updates.

To set this, go to Window -> Preferences -> General -> Workspace -> Check Save automatically

before build -> OK
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Automatic Updates

- ~
= Preferences l_I_I_JEI e e
type filter text Automatic Updates (=T T

> G |

Ae:era [¥] Automatically find new updates and notify me
> An
» CfC++

Changelog Update schedule
:» Help o ook for updates each time Eclipse is started
a ) Look for updates en the following schedule:

Avallable Sottware Sites
> Java
> Library Hover
> Mylyn
> Remote Systems
> Run/Debug
> Specfile Editor
> Team
Terminal
> Tracing
> WPILib Preferences

Il m b

Every day 1:00 AM

Download optiens
@ Search for updates and notify me when they are available

) Download new updates automatically and netify me when ready to install them

When updates are feund

@ Motify me once about updates

) Remind me about updates eveny:
30 minutes

["] Directly show update wizard

’ Restore Defaults] ’ Apply

)

T |

Cancel

)

Another recommended setting is enabling Automatic Updates. With Automatic Updates enabled,
Eclipse will check for updated versions of the plugins each time it starts and inform you if an
update is available. This will help insure you are notified of new versions of the WPILib plugins.

To enable Automatic Updates, select Install/Update then Automatic Updates. Check the box at the
top to Automatically find new updates and notify me. Select the radio button to Look for updates
each time Eclipse is started. Then click OK.
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Installing the development plugins - Option 1: Online Install

Q)

{5 Welcome p

(Z) Help Contents

4’ Search be
Dynamic Help
Key Assist... Ctrl+Shift+L
Tips and Tricks...

4 Report Bug or Enhancement... ot
Cheat Sheets...

‘%9 Check for Updates
g+ Install New Software.|

& Install LI_I—EI e e
’_

Available Software

Select a site or enter the location of a site, ;).-_—
. =
Work it ST )
Find more software by working with the "Available Software Sites” preferences.
1
£ Add Repository &j
e—
Location: http:_a’_a’flrst.wpl.edu_a’FRCa'rDborlo_a'release.a'ecllpse.!e
N—
e Y
@ 0K e Cancel
[ Q! ]

It is recommended to install the plugins using this method, which requires an active internet
connection and fetches the plugins directly from the WPILib site. This will allow you to check for
updates to the plugins using Eclipse.

Eclipse extensions are based on user-installed plugins. To get the WPILib development tools you
will need to install the correct plugin for your language.

When Eclipse starts:

1. Select "Help"

2. Click "Install new software".

3. From here you need to add a software update site, the location where the plugins will be
downloaded. Push the "Add..." button then fill in the "Add Repository" dialog with:

4. Name: FRC Plugins

Location: http://first.wpi.edu/FRC/roborio/release/eclipse/
6. Click "OK".

U
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Selecting the correct plugins

2 Install B[
Available Software

Check the items that you wish to install. )l_
Work with:  WPILib Release - http://first.wpi.ecu/FRC/roborio/release/eclipse/ - Add..
Find more software by working with the “Available Software Sites” preferences.
type filter text
ne Version
153 [7] 100 WPILib Robot Development
P
7] (- Robot C++ Development 0102014101546
7] (5 Robot Java Development 010201410111546
Select Al Deselect All 2 items selected
Details
Show only the latest versions of available software Hide items that are already installed
[7] Group items by category What is already installed?

[ Show only software applicable to target environmant
Contact all update sites during install to find required software

@ < Bad Next > Finish Cancel

2 Security Waming B |
arming: You are installing software that contains unsigned content, The authenticity
B\ or ualicity of this software cannot be established. Do you want to continue with the
installation? H
oK [ concel ][ Detoitsz> |
P
2 Software Updates =)
=) You will necdto restart Eclpse for the changesto toke effect. Would you like to
) restart nowt

iz

1. Click the arrows if necessary to expand the WPILib Robot Development menu.

2. Select the WPILib Robot Development plugin for your desired language (you can install both if
you wish to try programming in both languages)

3. Click Next, Next on the next page, then click the radio button to accept the license agreement
and click Finish

4. If you receive a Security Warning prompt, click OK to continue.

When prompted, restart Eclipse. After Eclipse restarts and you select your Workspace (if

prompted) you will see a dialog that says Installing Java. This details the installation progress of

the plugins, wait for the install to complete before proceeding. This dialog should only appear

when the plugins are first installed or updated.

d
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Installing the development plugins - Option 2: Download and
install offline

“Q

i ifal Welcome p

(7) Help Contents
4 Search be

Dynamic Help

Key Assist... Ctrl+Shift+L
Tips and Tricks...

4 Report Bug or Enhancement... ot
Cheat Sheets...

%y Check for Updates
g% Install New Software.|
——e

= Install l =R X
Available Software
Select a site or enter the location of a site. ;)-—_—
. a8 =
Work with: - Add
Find more software by working with the "Available Software Sites” preferences.
£ Add Repository &J

MName: FRC plu in5°
plug

Location: http:_e'_ffirst.wpi .edu/FRC/roborio/release/eclipse/

|f?:| [ 0K @ [ Cancel ]

If you need to download the plugins and install them on a different machine offline, you will be
unable to check for updates using Eclipse. Download the zipfile containing the plugins
from-thttp://first.wpi.edu/FRC/roborio/release/ Right click on the zip and select Extract All to
extract the files.

When Eclipse starts:

1. Select "Help"

2. Click "Install new software".

From here you need to add the downloaded plugin location. Push the "Add..." button then fill in
the "Add Repository" dialog with:

Name: FRC Plugins Offline

Click Local

Browse to the "site" directory inside the directory you extracted the zip file to.

Click "OK".

w

Nouwuhs
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Selecting the correct plugins

2 Install B[
Available Software
Check the items that you wish to install. )l_
Work with:  WPILib Release - http://first.wpi.ecu/FRC/roborio/release/eclipse/ - Add..
Find more software by working with the “Available Software Sites” preferences.
type filter text
one Version

153 [7] 100 WPILib Robot Development
°1 (§- Robot C++ Development 0.1.0201410111546
7] (- Robot Java Development 010201410111546

Select All Deselect All 2items selected

V] Show only the Iatest versions of available software

] Contact all update sites during installto find required software

@ < Bac Next > Finish Cancel
2 Security Waming (R X
Warning: You are installing software that conteins unsigned content, The authenticity
L\ o1 valicity of this software cannot be established. Do you want to continue with the
installation? H
oK [ concel ][ Detoitsz> |
P
2 Software Updates =)
=) You will necdto restart Eclpse for the changesto toke effect. Would you like to
restart now?
E

1. Click the arrows if necessary to expand the WPILib Robot Development menu.

2. Select the WPILib Robot Development plugin for your desired language (you can install both if
you wish to try programming in both languages)

3. Click Next, Next on the next page, then click the radio button to accept the license agreement
and click Finish

4. If you receive a Security Warning prompt, click OK to continue.

When prompted, restart Eclipse. After Eclipse restarts and you select your Workspace (if

prompted) you will see a dialog that says Installing Java. This details the installation progress of

the plugins, wait for the install to complete before proceeding. This dialog should only appear

when the plugins are first installed or updated.

d

If updated plugins are released, you can either repeat this process ( you will get one additional
Eclipse window telling you that the components are already installed and an upgrade will be
performed instead of an install), or if online installation is an option, you can complete the online
installation steps above, then get future updates using the Eclipse Automatic Updates (or the
manual update check described below)
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Updating the plugins manually

| pluginsVerification - Parallels Desktop

ib Run  Window [Help]

©f* &% - I@:I Welcome - - i
B (%) Help Contents
@ // Name % Search
Dynamic Help

// Name Key Assist... Ctrl+Shift+L

ijuth?F Tips and Tricks...

/{ Version

// Copyright ,{f’ Report Bug or Enhancement...

// Descriptig Cheat Sheets...

. Eclipse Marketplace...
#include "WPI

Check for Updates
~ class Robot ; Install Mew Software...
private:
Livelindg About Eclipse

= virtual void RobotImit() {

Tw = I dweldindrwe «GatTRetanca

Note: This only works if the plugins were installed using Option 1 - Online Install from above. For
updating plugins when the offline install was used, see the note at the end of the step above.

If you choose not to enable Automatic Updates as described above, you will need to manually have
Eclipse check for updates to install new versions of the plugins.

Select Help from the menu bar, followed by Check for updates. Eclipse will check if there is a newer
version available of any installed plugin and inform you if an update is found. Updating the plugins
will ensure that your development system is up to date with the latest version of the development

tools.

Troubleshooting

Below are some troubleshooting steps for commonly encountered issues
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Unable to read repository at http://first.wpi.edu/FRC/roborio/release/
eclipse/content.xml

- & Preferences

type filter text

a4 General
- Appearance
Compare/Patch
Content Types
» Editors
Globalization
Keys
> Network Connectior
Perspectives
Search
- Security
> Startup and Shutdoy
Web Browser
- Workspace
> Ant
s IC++
Changelog
> Help
> Install/Update
> Java
> Library Hover
> Mylyn
> Remote Systems
] n b

L | 5
Network Connections Ll A 4
Active Provider
Proxy entries
Sche.. Host Pert Provi... Auth User Edit...
[F] HTTP Man... Mo
Clear
[[] HTTPS Man... No
[] SOCKS Man... No
] i r
Prowxy bypass
Host Provider Add Host...
[[] localhost Manual Edit
] 1z7.001 Manual
Remove
[Restore Defaults] [ Apply ]
[ QK l ’ Cancel ]

This error occurs if Eclipse cannot contact the server to download the plugins. There are a couple
possible causes of this issue:

1.
2.
3.
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Your computer is not connected to the Internet. Verify your network connection and try again.
Your firewall is blocking Eclipse. Try adding an exception for Eclipse or disabling your Firewall.
Your proxy settings were read improperly by Eclipse. In Eclipse Select Window->Preferences-
>General->Network Connections. If you don't use a proxy or don't know, set the Active Provider
to Direct. If you use a proxy set the Active Provider to Manual and configure the proxy
information by selecting the protocol and clicking Edit.

Page 22



Installing Eclipse (C++/Java)

Need Java 1.7 or newer

If you get an error message when attempting to run Eclipse that says you "need Java 1.7 or newer",
you have mismatched versions of Java and Eclipse installed. The easiest fix is to go back and
download the other version of Eclipse (32 bit if you had 64, 64 if you had 32).
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